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Digital Rights Management:
How Will The Show End?
Andy Marken, President of Marken Communications, returns as General
Meeting guest speaker on the SECOND Friday of September (the 14th),
to give us a detailed, insider’s look at Digital Rights Management (DRM)
and the probable outcome for the industry and the consumer. “DRM” is a
catchall term for access control technologies used by publishers and other
copyright holders to limit the use of digital media or devices, and to
restrictions of specific digital works or devices. It somewhat overlaps with
copy protection, but usually refers to creative media (music, films), whereas
copy protection usually refers to software. It’s controversial because
supporters say copyright holders need to stop unauthorized duplication of
their work, whereas opponents say that using  the word “rights” is misleading
(they say that copyright holders are restricting the use of material in ways
not included in existing laws, and that DRM schemes are anti-competitive).

Andy, a twenty-year veteran of the content production and storage industry,
will explain why he believes that recent content protection for hackers and
press coverage will benefit us, the consumer, in the long-term and in a far
different way than hackers anticipate. Andy was public relations counsel to
Philips and has been involved with portable and removable storage ever
since, working with firms such as Matsushita, ADS Tech, Mitsubishi,
Panasonic, and many others as well as pioneers in the Internet industry. A
widely published industry commentator, today Andy is venturing into the
very touchy area of content management, security, and ownership. 

For information on content development and storage visit http://
www.markencom.com. If you have questions in advance, e-mail
andy@markencom.com.�

SECOND Friday of the Month:
September 14th 2007 at 7pm
Pacific Grove Adult Education Center

1025 Lighthouse Avenue, Pacific Grove
FREE to MBUG Members and the General Public.

Great coffee, yummy snacks, and very smart,
interesting people!

Did we hear
something about a

DESSERT
POTLUCK

in October?

The rumors are entirely
TRUE: turn to page 14

where we dish the
delicious details!
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�(831) 655-4443 and 657-4154

Open Volunteer Positions Available Now at MBUG !

MBUG-PC BOARD OF DIRECTORS

SUBSCRIPTION: See back cover for rates.
NEWSLETTER AD RATES: Special rate for local
business card ads (approximately 1/10 page) is $30.00
for 6 issues or $50.00 for 12 issues. Full and partial page
ad rates are available upon request. MBUG will publish
at no charge classified ads for individual subscribers who
have computer hardware or software for private sale.
For advertising information contact Regina at
ReginaDoyle@aol.com.
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THINGS, THINGLETS
& THINGASSOS

S. Jack Lewtschuk
MBUG-PC
Columnist
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ARE YOU GOOGELING?

The name “Google” originated from a misspelling
of “googol,” which refers to 10100 (the number
represented by a 1 followed by one-hundred zeros).
The verb “google” was added to the Merriam
Webster Collegiate Dictionary and the Oxford
English Dictionary, meaning “to use the Google
search engine to obtain information on the
Internet”.

Definition from “The Free Dictionary” at http://
encyclopedia.thefreedictionary.com

Maybe you are, but do you use all of Google’s
capabilities? Check it out at http://www.google.com/intl/
en/help/cheatsheet.html.

ARE YOU TIRED OF BEING LOCKED IN THE
PHONE JAIL?
Is your index finger covered with a callus from pushing
buttons on your telephone keypad? Are you angry,
disappointed and frustrated? Try http://
www.gethuman.com/. You might get to speak with a
human yet.

“HOMOGRAPH” SCAM
All of us have seen spam messages with misspelled
words used in the subject line to defy filters, such as
“v’agra”, “Reflnance”, “seksual”, etc.

Now it appears that scammers are registering
international websites with names spelled using mixed
alphabets. An example would be mixing letters from
the Latin alphabet with letters from the Cyrillic alphabet.

You can use your imagination to see how confusing this
can be. Just a few examples: the Cyrillic letters Y, H, B,
P and C are sequentially equivalent to the Latin letters
U, N, V, R, S, (etc.).

GOT FRAUD?
Another good website to file in your “Favorites” or
“Bookmark” file is http://www.fraud.org/welcome.htm.
This site includes:
�Telemarketing Fraud
�Internet Fraud
�Elder Fraud
�Scams Against Businesses
�Counterfeit Drugs
�Online Complaint Forms
�Call Center 800 Numbers
�Monthly News (regarding current fraud information).

NORTON/SYMANTEC REMOVAL TOOL
I recall that several years ago, when I needed to uninstall
Norton Antivirus I asked Symantec to send me the
instructions, and a short time later a three page document
arrived. Well, now it is a bit easier. If you need to
uninstall a 2003 or later Norton product, follow these
instructions:

1. Go to www.google.com
2. Type “SYMNRT”
3. Click “SEARCH GOOGLE”
4. Click and download “Download and run the Norton
Removal Tool”
5. Follow instructions.

NOVICE CORNER
Internet Basics
Do you or anyone you know need to brush-up on any
subject listed below? Slide on over to http://
www.internet101.org to read about:
�Internet Basics
  How It Works
    Internet Access
�E-mail
�Free E-mail
�The Web
�Newsgroups
�Online Safety
�Viruses
�Spyware
�Blogs

�Searching Street and e-
mail Addresses
�Finding Web Addresses
�Software
�Browsers
�Browser Toolbars
�Chatting/File Sharing
�Internet Goodies
 About Shopping
�Web Portals
�Terminology
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Virtual Memory
Your computer uses random access memory (RAM)
to store data for programs that are currently running.
Windows XP alone requires 128 MB of RAM. If you
want to run programs you’re going to need much more
than that to get by. I generally recommend 512 MB.
Thinking of running Vista? You’ll need 1 GB or more.

Virtual memory is designed to complement your
computer’s physical memory. It creates a paging file, or
swap file, on your hard drive as programs request
memory, RAM overflows, and Windows moves data to
your hard drive.

But there’s a downside: hard drives are relatively slow,
so programs won’t respond as quickly. This is why
people always tell you that having a lot of RAM is
beneficial.

You’re probably best off to let Windows manage the
size of your computer’s virtual memory—it adjusts the
size as needed. However, you can set your computer’s
virtual memory yourself if you prefer. Generally, you
will want to set the minimum size to 1.5 times your
physical memory. You can also specify a maximum size.
Set the maximum size to the same size as the minimum.
This will help speed things up. If you get warnings,
enlarge both minimum and maximum.

To change the size of your paging file, click “Start” and
right-click “My Computer.” Click “Properties” and
select the “Advanced” tab. Under “Performance,” click
“Settings.” Open the “Advanced” tab. Under “Virtual
memory,” click “Change.”

Now, select the “C: drive.” Click “Custom size” and
enter the minimum and maximum sizes. Click “Set” and
“OK.” Click “OK” on the other open dialog boxes.
If your hard drive is partitioned, or you have multiple
hard drives, you can accelerate virtual memory. Place
the paging file on a hard drive that doesn’t contain the
operating system. In that case, select “No paging file”
for the C: drive.

QT (QUICK TIP)
Quickly change the association of a file by holding down
the “Shift” key, right click a file and choose “open
with.”�                                         blacklion@royal.net

MBUG-PC MEMBERS
LENDING LIBRARY

Circulation Policy
General: MBUG members may check out

books/CD’s at meetings by
contacting the Library

Coordinator at least one day
in advance by e-mail or
phone call. Provide the

requested title and
member’s name, address,

phone, and e-mail information. The
coordinator will verify membership.

Circulation: Initial checkout is for one month.
Borrowers sign a checkout card when

receiving the item. Loans are renewable for
one additional month by e-mail or phone call
to Library Coordinator if there are no pending

requests.

Current Titles: 9Adobe Photoshop CS3 One-
On-One (O’Reilly) (with DVD)
9Adobe Photoshop Elements 5.0:
Classroom in a Book (with CD)

9Dynamic Learning: Photoshop CS3 (O’Reilly)
9Microsoft Office 2007: Visual QuickStart Guide
9Microsoft Office PowerPoint 2003 for Windows:

Visual QuickStart Guide 9Microsoft Windows
Vista: Visual QuickStart Guide 9Photoshop

Elements 5: Visual Quick Start Guide
9Working Smart in Adobe Photoshop CS2

Book Return: Return items to the coordinator
or other Board member at any MBUG
meeting. Please observe due dates in

consideration of other borrowers.

Responsibility: The borrower is responsible
for maintaining books and other items in good

condition. Lost, damaged, or long overdue
items are subject to a replacement charge.

Library Coordinator:  Contact Carolyn Lake
at 643-2023 or e-mail lakelyn@comcast.net�
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MS Word 2007 has some fun new tools (Live Preview,
SmartArt), but first new users have a challenging
learning curve just to locate standard tools and functions
to format, save, and print basic documents. Unless you
are very comfortable with Word 2002/2003 and enjoy
experimental approaches to new programs, I strongly
recommend step-by-step reference books to guide you.
Word 2007 has far more icons and graphics than previous
versions and it takes some time to identify them and
explore how they work. Three books to check are:

• Teach Yourself Visually Word 2007, by Elaine
Marmel, Wiley Publishing, Inc.

• Microsoft Office Word 2007 (QuickSteps
Series), by Marty Matthews et al, McGraw Hill/
Osborne

• Microsoft Office 2007 (Visual QuickStart
Guide), by Steve Schwartz, Peachpit Press

In her Introduction to Microsoft Office 2007 at the
August 3 General Meeting, computer trainer Debbie
Jones from Anything is Possible shared several
highlights of the new Word program. Two significant
changes are the use of a tab system to organize
commands and the use of “ribbons” (lines of icons
associated with each tab). Main menu headings are
renamed and reorganized as “Home,” “Insert,” “Page
Layout,” “References,” “Mailings,” “Review,” and
“View.” In the Word screen, an “Office Button” icon
replaces the “File” menu and leads to basic commands,
such as “New,” “Open,” “Save,” “Save As,” and “Print.”
At the bottom of the “Office Button” window, the “Word
Options” button, which groups all of the customizing
options previously shown on the “Tools” menu.

Clicking on a menu option will display it as a “tab,” and
instead of a list of sub-commands, a new “ribbon” of

MEETING
REVIEW

Carolyn Lake
Vice President/
Programs & Publicity
Team Chairman/
Library Coordinator

Debbie Jones on
Microsoft Office 2007ph
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related icons is displayed. The “Home” tab, for instance,
contains basic formatting commands for font, font size,
alignment, etc., all in icon form, familiar from previous
versions. The new “Page Layout” menu option (formerly
under the “File” menu) provides easy, visual access to
icons such as for margins and paper size and orientation.

A “Quick Access Toolbar” can be customized to make
frequently used icons available. This toolbar is a small
group of icons that sits on the left of the title bar, next to
the “Office Button.” Click on the down-arrow on the
bar to see more options. And if the document has been
saved, notice that the file extension in the title bar is
now “.docx” instead of “.doc.” Roll over the “Save As”
to see a sub-menu of file formats, each with a few words
of explanation—a nice feature. Files to be shared with
others without Word 2007 can be saved as a “Word 97-
2003 Document” and will have the older “.doc” file
extension. An Office 2003 user can also download an
add-on to open 2007 documents (“.docx!”).
 
Another new feature is the “Mini Tool Bar,” which
appears whenever text is highlighted, at first faintly in
the background, then clearly when the pointer rolls over
it (grouping the common text formatting commands).

On the “Insert” menu, the “Table” insert icon illustrates
the use of “Live Preview.” For example, when a table is
inserted, the icons change dynamically and extra related
tabs are also added. Rolling over the color choices for
the table will preview choices. Also, in “Page Layout,”
click on “Page Color” and roll over the choices to see
the entire background change in “Live Preview”! The
same applies to fonts: highlight text and hover the pointer
over the font names (drop-down under the “Home” menu
tab) to see the font change dynamically.

The “Insert” menu has most of Word 2007’s new graphic
fun: cover page templates are insert-ready, as well as
the familiar “Picture,” “Clip Art,” “WordArt” and
“Hyperlink.” “SmartArt” is new, providing diagram
shapes to insert and format many ways, to add color
changes, shadows, 3-D effects, text, and much more.

And a favorite new tool—at the bottom of the Word
screen is a slide bar for instant zooming in and out, from
10 up to 500 percent—great for managing page size
display!�                                    lakelyn@comcast.net
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Create Your Own Website—For Free!
In my previous column (MBUG-PC Newsletter July
2007) I described how to have your personal Internet
domain, website and e-mail address hosted for very little
cost. I left the question unanswered about how to actually
populate your website with a home page and other
goodies. Of course, you can pay big bucks for something
like Adobe DreamWeaver and make beautiful web
pages, but for an amateur personal website such expense
would probably be overkill for most of us. I know it
was for me, but then I am the Frugal Computerist.

There are many completely free ways to build a website,
including WYSIWYG (What You See Is What You Get)
editors with capabilities that rival those of
DreamWeaver. The first bit of software that you will
need is an HTML editor. HTML stands for HyperText
Markup Language and it is the basis of all web pages. A
web page is just a text document with HTML statements
and possibly a few other things on it; consequently, you
can build a web page with any text editor or a word
processor in non-document (plain text) mode. Just get a
book on HTML programming and get to work. It’s not
that hard. The book will have many examples that you
can use to get started. Just be sure to save your files as
plain text or they won’t work.

Some word processors will allow you to save directly
as HTML essentially acting as a site editor for you, but
the features may be too limited. See below for
information about the free Open Office which does have
quite good HTML features. One would expect that
anything you can create in your word processor can be
saved as web pages if it has the “Save as HTML” feature.

THE FRUGAL
COMPUTERIST

by Bob “I Don’t Do
Windows” Stephan

In your browser under the “View” menu you will also
find “Page Source” which will let you view the source
text of the page you currently have loaded. But don’t let
this scare you. Many professional websites have much
more complicated HTML than you will need in order to
get started.

A Quick Start
Don’t tell anyone I told you this, but you can start with
a web page that you might find on the ‘net which looks
good to you and which you might like to emulate. When
you view a web page in your browser, in the “File” menu
you will find “Save Page As ...” that will allow you to
download a web page to your own computer. Then you
can open it in the HTML editor of your choice and
modify it beyond all recognition (to avoid copyright
problems) to suit your own needs. This is really a quick-
start method and will get you off to having your own
web page in very short order.

I think you will find that any computer programmer will
(perhaps reluctantly) admit to cloning other programs
that he has found that almost do what he wants but which
needs a little tweaking for his purpose (by the way, “he”
and “his” can refer to either sex here.) It is an excellent
way of learning, and you can branch out to more
creativity later. A similar way to start is to use a template,
several of which may be provided with some site editors
and perhaps some books on the subject.

Free HTML Editors
For an extensive, but not exhaustive, list of possible
HTML editors just take a look at
www.thefreecountry.com/webmaster/htmleditors.shtml.
They range from simple text editors to full-featured
WYSIWYG editors. The information on this page can
tell you much more about what’s available than I have
room for here and this site has many links to other useful
pages such as, for example, “How to Create/Start Your
Own Website: The Beginner’s Guide.”

Over the past several years I have used a variety of
HTML WYSIWYG editors, including DreamWeaver,
with some success. Most of these were variations on
the editing component of Netscape called Composer.
Several of these are on the freecountry site listed above
along with links to reviews that tell you what features
they have and don’t have, and how well they work.
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Lately I have been using the most recent formulation
called Nvu (pronounced N-view for “New View”). See
www.nvu.com for detailed information and downloads,
and for another good beginner’s tutorial, see “How to
Design and Publish Your Website with Nvu” at
www.thesitewizard.com/gettingstarted/nvu1.shtml.

Here is an excerpt from this tutorial:

You will be greeted with a window that contains
a menu (the top line of the window that says “File
Edit View Insert...” etc), a few lines of toolbars
(containing buttons like “New”, “Open”, etc), a
left panel with a heading “Nvu Site Manager”,
and a large pane on the right-hand side that has a
tab called “Untitled”. This large pane is where you
will design your web page.

… You don’t have to do anything special - just
start typing. Note that you can type whatever you
wish …

Does this sound like what you see and do in your word
processor? You will find that Nvu is as easy to use as
your favorite word processor. The Help feature of Nvu
is very complete and professional looking and will
answer your questions. As mentioned, Nvu is based on
the Mozilla Composer web editor (which in turn came
from Netscape) and includes many new features making
it more powerful and easier to use. This open source
editor is available for Linux, OS/2 and (of course)
Windows.

Publishing Your Site
I have found that Nvu works very well for WYSIWYG
drag-and-drop website building and editing, but it also
has a site manager/publishing feature. To “publish” a
page or a site means to transfer it from your computer to
your website space on the Internet so it can be accessed
by others.

The transfer is done via FTP (File Transfer Protocol) so
you will need an FTP capable program. Nvu can easily
do that for you and it works well, but I have also found
something else for that purpose and it is just as free. It is
called DataFreeway and can be downloaded at
www.enginsite.com/ssh-webdav-ftp-sftp-client.htm. Or
just go to www.enginsite.com and click on

“DataFreeway.” I have found that DataFreeway does a
great job of transferring websites consisting of any
number of web pages and files, and does it very
efficiently.

There you have it. That’s all you need to know to get
started creating your very own website for whatever
purpose you might have in mind. I’d like to know what
you do to publish a website. If you have other ideas
write them up for the newsletter and let us know about
them. All submissions would be of interest to many of
us.

Who Needs Word?
While we are on the subject of free software don’t forget
about OpenOffice.org. OOo is a full-featured office suite
that is compatible with MS Office and other office
products and it costs nothing, nada, zip! I’ve been using
one version or another of it for years and have never
had a compatibility problem. Why spend the big bucks
for an OOo wannabe? I think that 99 percent of us will
find OOo perfectly satisfies all our office needs while
perhaps 1 percent might have some special requirements,
but I don’t know what they might be. Just check it out at
www.openoffice.org (note the “.org,” not “.com!”)

So, what’s the tie in? Well, as mentioned above in OOo
you can create or edit an HTML document. This should
get you started with at least a minimal web page, but
I’m not sure how extensive the HTML capabilities are.
Perhaps I will explore the features in a future column.
To give it a try just open up the file menu, select New,
and then HTML document, and away you go. Like Nvu
just start typing and do whatever you do in your word
processor to create a document. To check your work,
just view the file in your browser after saving it.

The current version of OOo is 2.2.1. If you are using an
older version it is recommended that you upgrade
because it fixes some vulnerabilities. For more details
and a link to download go to why.openoffice.org.�

Bob “I don’t do Windows” Stephan is an OS/2 enthusiast
with over 40 years of computing experience. He
welcomes comments and questions that The Frugal
Computerist can respond to by email to
stephan.bob@gmail.com. Bob’s home page is at
www.bobstephan.net.
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TUT–The Ultimate
Troubleshooter

by Ira Wilsker,
APCUG Director,

Columnist The Beaumont
Texas Examiner,

Radio/TV Show Host

According to a British website,
Answers That Work
(www.answersthatwork.com), 65
percent of problems on PCs, such as
lockups, crashes, “blue screens of
death,” and poor performance are
due to causes other than the
commonly suspected culprits. Many
people erroneously blame malware
such as viruses or spyware for the
problems on their computers, and
some go to extreme measures to
attempt to resolve these problems.

Unbeknownst to the users of
computers with the symptoms
above, the problems they are
experiencing are not due to the
possible presence of malware, but to
background tasks that are loaded and
running mostly from the software the

users have installed on their
computers.
A solution to improve performance
by giving the user easy and informed
control over the tasks running on the
computer is a $29 program called
The Ultimate Troubleshooter,
commonly known in industry circles
by its acronym, TUT.  TUT is a
compilation of solutions learned
based on over 20 years experience
trouble shooting computers.

For the past four years I have
diagnosed my computers using TUT,
and have been able to tweak them
and maximize performance based on
the recommendations made possible
by the software.  One of the
functions integral in TUT is its
“PC Tuning” service which uses
its extensive database of tasks that
may be running on a PC, and the
degree of necessity of that task.

As I type this, I have 45 tasks
running on my computer, and TUT
displays each of the tasks running
and explains the functionality in
understandable terms. Each task
can be managed by the user such that
only necessary tasks are running,
which will free up system resources
resulting in improved performance.
Each of the running tasks is labeled

by status (unknown,
user’s choice, multiple
possibilities, OK, and
Not OK), task name,
CPU usage of each
task, memory being
used, manufacturers’
description, and other
technical information
is displayed.  Right
clicking on a task will
allow the user to
terminate the task,

suspend the task, or get additional
information about the task.

Many users are plagued with slow
booting of their machines when
turned on and subsequent impaired
performance.  The primary cause of
this malady is too many or
unnecessary programs loaded when
the computer is booted.  The startup
sequence becomes bloated as
software is installed, as many
programs want to be automatically
loaded every time the computer is
started, and this can degrade
performance.  TUT contains one of
the most comprehensive startup
managers available.

SOFTWARESOFTWARESOFTWARESOFTWARESOFTWARE
REVIEW

The “Startups” function of TUT
displays each program that is loaded
when booted, regardless of whether
the program is loaded from the
startup file, registry or other source.
Each program is labeled by status,
startup name, launch command,
manufacturer, description, and
startup source.  The status indicator
shows if the programs are necessary
and OK (green), user’s choice
(yellow), dangerous or otherwise
unnecessary (red), or unknown (no
color tag).  By removing any red
tagged startup items (which may also
be viruses or spyware) dangerous
and otherwise useless items will not
be loaded at the next boot.
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(NF)

For those who want to know about
websites and other Internet
information, TUT offers several

utilities, including the
identification and display of the
computers IP address (TCP/IP
configuration, MAC address, etc.),
name server lookup, ping, trace
route (shows the path that internet
connections follow over the
Internet) and “whois” (displays the
registered owner of a website).

One nice service provided by TUT
is the frequent updates of its
database, as well as periodic updates
of the software itself.  As I type this,
I am using TUT version 4.21, which
is an update from the recently
released version 4.0.

TUT version 4 works on Windows
2000, XP, Win2003, and 32-bit
versions of Vista. For the bargain
price of $29, I found that TUT is an
indispensable utility for diagnosing
computer problems and improving
PC performance.

Its full name, The Ultimate
Troubleshooter is a well-earned
moniker, and I strongly recommend
it.  A free demo version is available
to download from
www.answersthatwork.com so users
can examine the product prior to
purchase.�

Iwilsker@apcug.net

Obtained from APCUG with the
author’s permission for publication
by APCUG member groups. This
article has been provided to APCUG
by the author solely for publication
by APCUG member groups. All
other uses require the permission of
the author (e-mail address above).

“System Info” displays
comprehensive information about
the machine and its software.  The
“System Summary” displays
detailed information about the
motherboard, BIOS, CPU, graphics
card, operating system, memory, disc
drives, and other information.

Detailed information about
components is often necessary for
maintenance and update purposes,
and TUT provides that
information.  Details are also
provided about the cache memory,
comm ports, drives,
environmental variables, graphics
card and settings, and many other
computer components.

Installed software is also listed in
detail, along with a helpful adjunct;
TUT also displays an internet “Help
Link” for more information from the
software publisher, and as a resource
for updates and upgrades.  Other
hardware and software information
is listed as well.  One helpful feature
is a complete listing of Windows
updates that shows the date of the
update, a simple description of the
update, and the Microsoft
Knowledge Base (KB) number for
additional information from the
original source.

The “Housekeeping” function of
TUT allows the user to selectively
clean junk files from the hard drive,
freeing up disk space.  Housekeeping
also runs a PC health check to
determine the operating condition of
the computer.  Freeing up drive space
and ceasing unnecessary tasks
contributes to stability, another key
ingredient of overall system
performance.

For both informational and
maintenance purposes, it is often

useful to know precisely what
hardware and software is in and on
the computer.

The user’s choice (yellow) items can
be reviewed and selected or
deselected by the user by simply
utilizing a checkbox. Unchecking
an item will prevent it from
loading at next boot. Stopping
unnecessary items from loading at
boot will improve performance
and speed the boot performance.

The “Services” tab shows the
internal workings of the operating
system and other programs that are
running at the moment.  Right
clicking on a running service allows
the user to control the service by
stopping it, and control loading and
execution of the service item at
startup.  The traditional red/yellow/
green indicator on each clearly
indicates the degree of functionality,
necessity, and safety of each.
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1 yr 2 yrs 3 yrs
Computer Games $15.95  ——  ——
Computer Gaming World $14.95 $28.95 $41.95
Computer Shopper $16.97 $32.95 $47.95
Dr. Dobbs Journal $15.95  ——  ——
Mac Addict $10.97 $19.97 $28.97
Mac Life $10.97   $
Maximum PC $9.95 $18.95 $27.95
Microsoft System Journal $21.95 $39.95      ——
PC Gamer $12.95 $23.95 $33.95
PC Magazine (22/44/66 issues per yr.)

$25.97 $48.95 $68.95
PC World $16.95  ——  ——
Videomaker $11.95 $21.95  ——
Wired $10.00 $18.00  ——

For over 300 more titles, contact Herb by e-mail.
Prices are for new subscriptions & renewals. Send

check, cash or money order payable to:
Herb Goodman 8295 Sunlake Drive, Boca Raton
FL 33496 / phone (561) 488-4465 / hgoodman@

prodigy.net. Allow 10 - 12 weeks for magazines to
start. Renewals: Send address label from your

present subscription to ensure correct start.
Herb will mail a renewal notice 4 months prior to

expiration date.

HERB GOODMAN DISCOUNT
COMPUTER MAGAZINE PRICE LIST

Our Members can now get a 35% discount on
all books from O’Reilly as well as their “No

Starch”, “Paraglyph”, “PC Publishing”,
“Pragmatic Bookshelf”, “Sitepoint”, “Syngress”

and “YoungJin” publications. Use the same
code “DSUG” when ordering books online or
by phone at 1-800-998-9938. We still get free
ground shipping on orders of $29.95 or more
(in the US). Go to www.oreilly.com/store/ and

see what’s new!

O’Reilly catalogues are available at general
meetings.

 Want to know
more?

Contact:
Jack Lewtschuk

 blacklion@royal.net

FREE tech support
to both subscribers and non-subscribers.

1 (800) 368-8304 Mon-Fri 7am to 8pm CST
Saturdays from 8am to 4pm CST (Nebraska time)

or any time on the Internet:
webhelp@smartcomputing.com  or

www.smartcomputing.com

Subscribe to Smart Computing and benefit
MBUG-PC: use source code 8181 when ordering

and for every five subscriptions, we get one free for
our raffle to fund our educational activities.

12 issues for $29.00 / 24 issues for $48.00
36 issues for $64.00

To subscribe and renew with credit to MBUG,  follow
the instructions on page 6 in this issue.

Smart Computing

UPDATE:
MBUG-PC
Members
now get

35% off all

Go Green, Give to Charity,
Support Local Industry

Recycling empty computer ink cartridges through
MBUG helps prevent non-degradable plastic and
metal waste from polluting our landfills. At the
same time we make money for our educational

programs by selling them to a local (Monterey) ink-
refill company. We make it easy for you, too: just
drop your empties (any brand, any type) into the
brown box or give them to any Board Member at

General Meetings or workshops.�
ellias@msn.com

RECYCLE INK CARTRIDGES

O’Reilly Books and PDFs!

A TIP FROM JACK: Before subscribing or
renewing through the above, check if the

publisher has a current special price (which
happens periodically). � blacklion@royal.net
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�Jim Anway
STRICTLY  Wednesdays & Fridays

from 2pm to 5pm at 625-5618
�Lee Keely

Prefers e-mail at Lee@leekeely.com
or call 626-8033
�Bob Stephan

e-mail to stephan.bob@gmail.com
or call only between 9am-5pm

646-1373
�Clive Sanders

e-mail to simbacli@pacbell.net
or call only between 1pm to 9pm

phone (831) 375-5376 �

Computer Help - Just a Click or Call Away with MBUG F1
You know you push the  ‘F1’ button on
your computer when you need help.
But do you also know that  you can call
or e-mail MBUG-PC “F1 for Help”
with your computer questions?

Our expert team of F1 Volunteers will
share their experience on software and
hardware. To get computer help:

(1) Contact any of the people listed
below; or
(2) Ask questions during any MBUG-PC
meeting break or Q&A session; or
(3) Leave  Don Slaiter (831) 655-4443/
657-4154 a message; or
(4) Broadcast a message to all
members through the MBUG-PC
Listserv mbug@listserv.redshift.com)
in plain text only (NO html, please)!

See PGAEC catalog & web pages for
class descriptions.

Call: Computer Office  (831) 646-6657
or e-mail Bruce Cates: bcates@pgusd.org

http://www.pgusd.org

Vocational
Education
Computer

Classes

Pacific Grove
Adult
Education
Center

1025 Lighthouse Avenue
Pacific Grove CA 93950

“Learning for Life”
○

○

○

○

○

○
○
○
○
○
○

VOLUNTEER COMPUTER
COACHES/TEACHERS NEEDED

Sally Griffin Senior Center
in Pacific Grove

is in need of additional “computer coaches”
and instructors for their

Technology Access Program for Seniors.
The center provides older adults an

opportunity to learn and practice their
technical skills in a small lab, working one-

on-one and in a small class format.
If you have the time, ability and patience to
tutor beginners in a relaxed setting, contact
Andrea Fuerst at the Sally Griffin Senior

Center at (831) 375-4454 or e-mail
alcdir@mowmp.org

Services are free of charge
(with the understanding that MBUG-PC, its Board

of Directors, and the F1 Volunteers themselves are in no way responsible or liable for the
accuracy or the outcome of any advice or suggestions!)

F1            Jim           Lee          Bob        Clive
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Travel

� � � � � Dan Presser, Owner
26080 Carmel Rancho Blvd., Suite 103

Carmel CA 93923-8757  � � � � � (831) 622-0800
Fax (831) 622-9467 � � � � � CST #1000683-40

info@fourwindstravel.com

 MBUG-PC SUPPORTERS

James W. Anway
Retired IBMer
Computer Consultant

Phone: 831 625-5618
Fax: Call first

Star Reierson
star@computerpowerstar.com

FourWinds

1173 Ninth Street
Monterey CA 93940

Phone: (831) 373-3919
       Fax: (831) 373-0671

Where the good times begin
SM

Bob Weisensee
Production Supervisor

CREATIVE TECHNOLOGY
of Sarasota, Inc.
5969 Palmer Boulevard
Sarasota FL 34232-2841

bob@ctimls.com

Printer of the MBUG-PC Newsletter

(941) 371-2743 / FAX (941) 379-2933 / 1-800-533-1031

Dan Presser in Borneo discussing conservation
awareness with a local Headman.
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Cleaning House? Reorganizing? Getting A New PC?
MBUG needs new or gently used, working computer software, hardware, supplies, and

peripherals,  for fund-raising raffles (and cash donations too).
Call ahead to determine if your items can be put to use.

Contact Don Slaiter slaiter@pacbell.net

raffle items wanted
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O’Reilly New
Releases: Books,
Short Cuts, and
Rough Cuts

FREE BOOKS FOR REVIEW
This is a reminder that O’Reilly Books offers free computer-related books
to anyone who is willing to write a review and publish it in the MBUG-PC
Newsletter within a reasonable amount of time.

The procedure is simple:
1. Let me know which book you would like to review.
2. Write the review.
3. Send the review to Regina Doyle with a copy to me (so I can verify for
O’Reilly that you have done it).
4. Keep the book.

WHAT A DEAL!
For a list of books which O’Reilly offers for review go to: http://
www.oreilly.com/store/newreleases.csp.�

S. Jack Lewtschuk, blacklion@royal.net

Get 35 percent off from O’Reilly, No Starch, Paraglyph, PC
Publishing, Pragmatic Bookshelf, Rocky Nook, SitePoint, or
YoungJin books you purchase directly from O’Reilly. Use code
“DSUG” when ordering online or by phone 1 (800) 998-9938. Free
ground shipping on orders of $29.95 or more (www.oreilly.com).

See Jack’s reminder (above) to find out how you can request a
free book or PDF to review for MBUG-PC. For book review writing
tips and suggestions, go to http://ug.oreilly.com/bookreviews.html.

A Few Of the Newest Titles

�Designing Web Navigation
�Dynamic Learning: Flash
CS3 Professional
�FileMaker Pro 9: The
Missing Manual
�Google in Education
�iPhone: The Missing Manual
�JavaScript & DHTML
Cookbook, Second Edition
�Security Power Tools

�Microsoft Project 2007: The
Missing Manual
�Photoshop Lightroom
Adventure
�Programming Collective
Intelligence

�Visualizing Data: Rough
Cuts Version
�Windows Vista Accelerated
(Young Jin)�

my favorite
 WEBSITE

by Regina Doyle,
MBUG Newsletter Editor

Get Your Money
Back!

Many stores offer their own price
protection policies. Usually, if the
price drops on something you’ve just
bought, they’ll refund the difference
within a certain number of days of
purchase. The problem is that it’s up
to you to find out when or if the price
drops.

Price Protectr (priceprotectr.com)
notifies you when the price drops so
you can go back to the store to apply
for a refund. Best of all, (MBUG’s
Frugal Computerist Bob Stephan
will like this part), it’s free!

If you buy something from one of
the 35+ stores on Price Protectr’s
retailer’s index including Amazon,
Banana Republic, Best Buy,
Circuit City, Costco, Gap, Staples,
Radio Shack and Target (they add
new stores all the time), look up the
product information page for the
item you bought, copy and paste it
into your “shopping cart” (where the
item name and price appears
showing what you paid the day you
bought it), enter your e-mail address
(they promise not to spam you or sell
your address), and send your
“shopping cart” to them. If Price
Protectr notices a drop in the price
of your item(s) at any time within
the price protection period, they’ll
send you an e-mail (they keep
sending notices if the price keeps
dropping) so you can go claim your
money.� ReginaDoyle@aol.com
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ANNUAL MBUG MEMBERS/FAMILY/FRIENDS
GET TOGETHER

Interested in organizing wine by more than just “red”
and “white”? Jud Grubbs and Pat Landee of
Groundspace Corporation, Pebble Beach, will
demonstrate their product  Wine Notes 2.0, a wine

evaluation and selection tool, for use by  the
casual collector or connoisseur.

Designed for managing a wine cellar, the
software runs on PDAs or PCs using
Windows XP (soon to be Vista-compatible).
Interested? Contact Pat at 655-9907;
pat@pinotnoirs.com; or
www.groundspace.com/.�

COMING in OCTOBER

Jud Grubbs
& Pat Landee

Guest Speakers
Wednesday, September 26

7:00 to 9:00pm
Canterbury Woods

Auditorium, Pacific Grove

SEPTEMBER
WINE NOTES 2.0

EVALUATION SOFTWARE
 

Summer is slipping by rapidly but it’s not too late to share in a moment of MBUG fun!
Get together with members, family and friends to eat, drink, get to know each other, and share

computer problems/solutions and ideas for future meetings.

In lieu of an afternoon barbeque as held in past years,
and instead of a regular workshop on October 24, we are having a

DESSERT POTLUCK!
Wednesday, October 24

7 to 9pm / Canterbury Woods Auditorium

Details: Check the October Newsletter for final details. The DESSERT POTLUCK will be open to
members, their families and prospective members. Invite prospective candidates along!

Brief presentation, a little discussion, chat and laughter, raffle, and delicious dessert!

Price of Admission: Dessert for 8 to 10 people. Hot and cold drinks to be provided by MBUG.

Help Us Create A Special Raffle:
(1) Donate new or nearly-new computer-related items—books, hardware, or software—all

gratefully accepted.* Call Don Slaiter (655-4443) if you have questions, or bring items to any
MBUG function through October 10.

(2) Contact, or tell us about, suitable vendors from whom MBUG might get raffle items.
(3) Save your lottery ticket money and buy lots of tickets on October 24!

All proceeds benefit our educational activities.

*(Items will be sorted for the raffle, the “freebies” shelf, or responsible recycling)
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General Meeting Location
Adult Education Center, PG

1025 Lighthouse Avenue, Pacific Grove
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P.G. Adult Education Center
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Canterbury Woods
651 Sinex Avenue
Pacific Grove
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Hilltop Park Center
871 Jessie Street

Monterey
David Avenue (East of Hwy 68)
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Sunday Monday Tuesday Wednesday Thursday Friday Saturday

DIRECTORS’ MEETING
Canterbury Woods PG

Begins at 7pm
Everyone Welcome!

“Manage Wine Cellar w/
Wine Notes 2.0”

Canterbury Woods
7:00 - 9:00pm

J. Grubbs & P. Landee

“Digital Rights
Management”

Adult Ed Center PG
7:00 to 9:00pm
Andy Marken

LABOR DAY
HOLIDAY

MBUG Holiday:
NO

WORKSHOP

1 2 3 4 5 6

7 8 9 10 11 12 13

14 15 16 17 18 19 20

21 22 23 24 25 26 27

28 29 30 31

  Sunday   Monday   Tuesday    Wednesday    Thursday    Friday   Saturday

General Meeting
Topic & Speaker

To Be Announced
Adult Ed Center PG

7:00 to 9:00pm

ANNUAL MBUG
GET TOGETHER

Canterbury Woods
7:00 - 9:00pm

All Members Invited!

DIRECTORS’ MEETING
Canterbury Woods PG

Begins at 7pm
Everyone Welcome!

Tentative Calendar October 2007 Check the October Newsletter for Final Schedule

MBUG-PC Calendar of Events - SEPTEMBER  2007

 

General Meeting
on Second Friday

this month!

Workshop
Topic & Speaker

To Be Announced
Canterbury Woods

7:00 to 9:00pm

DIRECTORS’ MEETING
Canterbury Woods PG

Begins at 7pm
Everyone Welcome!

General Meeting
Topic & Speaker

To Be Announced
Adult Ed Center PG

7:00 to 9:00pm

November 2
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PO Box 51611
Pacific Grove

California  93950

Vol 26, No 9, September 2007

Check your Membership expiration date above.
Does it say “Exp: September / 2007”?
If so, renew your subscription today!

Enjoy the many benefits of MBUG membership and don’t miss
an issue of this fine, locally-produced publication. Membership
& Newsletter Subscription: Electronic $20, US Mail $25, both $35.

Additional tax-deductible donations welcome! Send your name,
address, phone number, e-mail address & check to: Monterey Bay

Users Group-PC, Box 51611, Pacific Grove CA 93950
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30% DISCOUNT ON COMPUTER BOOKS
FOR MBUG MEMBERS

 The Peachpit User Group Partner Program gives hefty discounts on
books ordered online! Click the Bookstore link at www.peachpit.com, to
view books on graphics applications, business productivity, operating

systems, digital lifestyle, and more. Discount at point of purchase using
group discount coupon code UE-23AA-PEUF

(case sensitive).

WELCOME NEW MEMBERS
name       member number
Bob Boynton ..........................1306
Jeff Helms ..............................1305

THANK YOU FOR YOUR
GENEROUS DONATIONS
Robert Chapman ......................636
Menko Rose .............................879
Alberta Sullivan ...........................6

THANKS FOR RENEWING
Jim Anway ...............................841
Bob Carr ....................................25
Eleanor Cetin .........................1011
Robert Chapman ......................636
Carol Meyer .............................556
Roy Miner ................................952
Menko Rose .............................879
John Sousa .............................1135
Alberta Sullivan ...........................6
Frank Wasko ............................888
Renati Mannan.......................1214
Larry Cotton ..........................1293

Get a juicy new computer book for
 FREE: jut write a review of a title

from www.peachpit.com, and
publish it here. Examples:

www.peachpit.com/usergroups.
Contact Carolyn Lake (831) 643-

2023 or lakelyn@ix.netcom.com.�

Review a PEACHPIT Book,
Keep it for FREE!


